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1 Product Overview 

1.1 Product Introduction 

XB6 series slice I/O modules feature a combination of couplers and I/O modules. The couplers connect 

extendable I/O modules to a real-time industrial Ethernet system. The I/O modules communication 

backplane is equipped with X-bus to provide high real-time performance and connects a variety of modules. 

It helps users collect high-speed data, optimize system configuration, simplify field wiring, and improve 

system reliability. 

1.2 Product Feature 

⚫ Fewer nodes required 

A node consists of a bus coupler, 1~32 X-bus series I/O modules and an end cover. 

⚫ Diverse functional expansion options 

Flexible expansion is supported, and a complete range of IO types are provided. It is possible to integrate 

digital, analog, temperature, pulse and other modules to meet different application needs 

⚫ Flexible configuration 

Multiple types of slice I/O modules are offered for free combination 

⚫ High compatibility 

The coupler communication interface conforms to industrial Ethernet communication standards and 

supports mainstream PROFINET master stations. 

⚫ Small footprint 

Compact structure and small footprint. 

⚫ Easy diagnosis 

An innovative channel indicator design is adopted. As the indicators are placed close to the channels, 

channel status is displayed intuitively and clearly, facilitating detection and maintenance. 

⚫ High speed 

X-bus on the backplane leads to a maximum scan cycle of 1ms 

⚫ Easy installation 

Installation on standard DIN 35 mm rails. 

Spring terminal blocks are used for convenient and fast wiring. 
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1.3 Application Configuration 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Application method： 

Different modules can be combined, including power supply, coupler, digital, analog, relay, temperature, 

and other modules. 

Application configuration： 

Different I/O module combinations can be adopted depending on master station access capacity, number 

of stations, I/O points, function type, and other requirements. 

Configuration rules： 

From left to right, the modules should be arranged in the order of power supply, coupler module, I/O modules, 

and cover plate (must be configured). 
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2  Designation Rules 

2.1 Designation Rules 

2.1.1 Coupler Designation Rules 

 

Item Value Description of the values 

（1） Bus type XB：X-bus backplane bus 

（2） Product line 6：Slice I/O 

（3） 

Bus protocol 

PN：PROFINET 

MT：Modbus TCP 

CL：CC-Link 

EI：EtherNet/IP 

EC：EtherCAT 

CB：CC-Link IE Field Basic 

CT：CC Link IE TSN 

（4） Power supply 20：2A 

（5） Number of Bus Interfaces 02：2*RJ45 

（6） Module type ST：Kit of power supply, coupler, and cover plate 
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2.1.2 I/O Modules Designation Rules 

 

Item Value Description of the values 

(1) Bus type XB：X-bus 

(2) Product line 6：Slice I/O 

(3) I/O module type 
A：Analog 

Blank：Digital 

(4) Number of inputs 
Analog：0、4、8 

Digital：0、8、16、32 

(5) Number of outputs 
Analog：0、4、8 

Digital：0、8、16、32 

(6) I/O characteristics 

Digital Analog 

Code Input Output Code Description 

A NPN NPN、0.25 A V -10~+10 V、0~+10 V 

B PNP PNP、0.5 A I 4~20 mA、0~20 mA 

BW PNP PNP、0.25A VW -10~+10 V、0~+10 V 

N NPN/PNP - IW 4~20 mA、0~20 mA 

AN - NPN、0.25A 
TM 

Resistance Temperature Detector 

(RTD), thermocouple (TC) BN - PNP、0.5A 
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2.2 List of common modules 

Model Product description 

XB6-MT2002ST Modbus TCP coupler kit (power supply + coupler + cover plate) 

XB6-P2000 Extension power module 

XB6-3200A 32-channel digital input module, NPN type 

XB6-3200B 32-channel digital input module, PNP type 

XB6-0032A 32-channel digital output module, NPN type 

XB6-0032B/XB6-0032BW 32-channel digital output module, PNP type 

XB6-1600A 16-channel digital input module, NPN type 

XB6-1600B 16-channel digital input module, PNP type 

XB6-0016A 16-channel digital output module, NPN type 

XB6-0016B/XB6-0016BW 16-channel digital output module, PNP type 

XB6-0800A 8-channel digital input module, NPN type 

XB6-0800B 8-channel digital input module, PNP type 

XB6-0008A 8-channel digital output module, NPN type 

XB6-0008B/XB6-0008BW 8-channel digital output module, PNP type 

XB6-1616A 16-channel digital I/O module, NPN type 

XB6-1616B/XB6-1616BW 16-channel digital I/O module, PNP type 

XB6-3200N 32-channel digital input, NPN/PNP compatible 

XB6-0032AN 32-channel digital output, NPN type 

XB6-0032BN 32-channel digital output, PNP type 

XB6-A80V 8-channel analog voltage input module 

Optional ranges： 

0~+10 V -10~+10 V 

XB6-A40V 4-channel analog voltage input module 

XB6-A08V 8-channel analog voltage output module 

XB6-A04V 4-channel analog voltage output module 

XB6-A80I 8-channel analog current input module 

Optional ranges： 

0~20 mA 、4~20 mA           

XB6-A40I 4-channel analog current input module 

XB6-A08I 8-channel analog current output module 

XB6-A04I 4-channel analog current output module 

XB6-A80VW 8-channel analog voltage input module 

Optional ranges： 

0~+10 V -10~+10 V 

XB6-A40VW 4-channel analog voltage input module 

XB6-A08VW 8-channel analog voltage output module 

XB6-A04VW 4-channel analog voltage output module 

XB6-A80IW 8-channel analog current input module 

Optional ranges： 

0~20 mA 、4~20 mA           

XB6-A40IW 4-channel analog current input module 

XB6-A08IW 8-channel analog current output module 

XB6-A04IW 4-channel analog current output module 

XB6-0012J 12-channel relay output module 

XB6-A40TM 4-channel thermal resistor and thermocouple temperature collection module 

XB6-A80TM 8-channel thermal resistor and thermocouple temperature collection module 

XX6-C18_2 Common terminal extended module 
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3 Product Parameters 

3.1 General parameters 

General technical parameters 

Size 

Power module 106X61X22.5 mm 

Coupler module 106X61X22.5 mm 

I/O module 106X73X25.7 mm 

Weight 

Power module 110 g 

Coupler module 80 g 

I/O module 90 g 

Working temperature -10~+60℃ 

Storage temperature -20℃~+75℃ 

Relative humidity 95%, non-condensing 

Protection degree IP20 

 

3.2 Power parameters 

Power parameters 

Power module 

Working power supply 18~36 VDC 

Output voltage 5 VDC 

Output current 2A 

Coupler module 
Working power supply 5 VDC 

Working current 400 mA 

I/O module  Working power supply 5 VDC 
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3.3 Interface parameters 

PROFINET interface parameters 

Bus protocol PROFINET 

Number of I/O stations Based on the PLC 

Data transmission medium Ethernet CAT5 cable 

Transmission distance ≤100 m (distance between stations) 

Transmission rate 100 Mbps 

Bus interface 2×RJ45 

3.4 Digital parameters 

Digital input 

Nominal voltage 24 VDC（±25%） 

Number of inputs 8、16、32 

Signal type NPN/ PNP 

“0” Signal Voltage (PNP) -3~+3 V 

“1” Signal Voltage (PNP) 15~30 V 

“0” Signal Voltage (NPN) 15~30 V 

“1” Signal Voltage (NPN) -3~+3 V 

Input filter 3 ms 

Input current 4 mA 

Isolation method Optically-coupled isolation 

Electrical isolation 500 V 

Channel indicator Green LED 

Digital output 

Nominal voltage 24 VDC（±25%） 

Number of outputs 8、16、32 

Signal type NPN/ PNP 

Load type resistive load, inductive load 

Single-channel rated current 

(A/B) 

NPN Type Max：250 mA  

PNP Type Max：500 mA 

BW Type Max：250mA 

Port protection Overvoltage and overcurrent protection 

Isolation method Optically-coupled isolation 

Electrical isolation 500 V 

Channel indicator Green LED 
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Relay output 

Nominal voltage 24 VDC（±25%） 

Number of outputs 12 

Isolation method Optocoupler, relay isolation 

Rated load 5 A 

Channel indicator Green LED 

 

3.5 Analog parameters 

3.5.1 Technical parameter 

Analog input 

Number of inputs 4、8 

Input signal (voltage type)  0~+10 V、-10 V~+10 V(adjustable range) 

Input signal (current type)  0~20 mA、4~20 mA(adjustable range) 

Resolution 16 bits 

Sampling rate 

XB6-A40V、XB6-A80V ≤1 ksps 

XB6-A40VW、XB6-A80VW ≤62.5 sps 

XB6-A40I、XB6-A80I ≤1 ksps 

XB6-A40IW ≤100 sps 

XB6-A80IW ≤62.5 sps 

Accuracy 

XB6-A40V、XB6-A80V ±0.1% 

XB6-A40VW、XB6-A80VW ±0.3% 

XB6-A40I、XB6-A80I ±0.1% 

XB6-A40IW、XB6-A80IW ±0.3% 

Internal resistance (voltage type) ≥2 kΩ 

Internal resistance (current type) 100 Ω 

Electrical isolation 500 V 

Channel indicator 绿色 LED 灯 

Temperature input 

Number of channels 4、8 

Sensor type Thermocouple Thermal resistor Resistor 

Connection type 2 wire method 2 / 3 wire method 2 wire method 

 K：-200~1370℃ 

J：-200~1200℃ 

E：-200~1000℃ 

S： -50~1690℃ 

B： 50~1800℃ 

Pt100：−200~850℃ 

Pt200：−200~600℃ 

Pt500：−200~600℃ 

Pt1000：−200~600℃ 

15Ω~3kΩ 

 

 

Accuracy ±0.5% ±1℃ ±0.1% 

Sensitivity 0.1℃ ±0.1Ω 

Resolution 16 bits (int type) 

Channel indicator Green LED 
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Analog output 

Number of outputs 4、8 

Output signal (voltage type)  0~+10 V、-10~+10 V(adjustable range) 

Output signal (current type)  0~20 mA、4~20 mA(adjustable range) 

Resolution 16 bits 

Accuracy 

XB6-A04V、XB6-A08V ±0.1% 

XB6-A04VW、XB6-A08VW ±0.3% 

XB6-A04I、XB6-A08I ±0.1% 

XB6-A04IW、XB6-A08IW ±0.3% 

Load impedance (voltage type) ≥2 kΩ 

Load impedance (current type) ≤200 Ω 

Electrical isolation 500 V 

Channel indicator Green LED 

 

3.5.2 Voltage I/O range selection and code value table 

Voltage I/O range selection and cold value range 

Range selection 0 1 2 3 

Range -10 V~+10 V 0~+10 V -10 V~+10 V 0~+10 V 

Code value range -32768~32767 0~32767 -27648~27648 0~27648 

Voltage input 

formula 
D=(65535/20)*U D=(32767/10)*U D=(55296/20)*U D=(27648/10)*U 

Voltage output 

formula 
U=(D*20)/65535 U=(D*10)/32767 U=(D*20)/55296 U=(D*10)/27648 

Code value table See Table 3-1 Voltage code values 

Note: D: code value; U: voltage 

  



XB6 Series PROFINET Slice I/O User Manual   3 Product Parameters 

10  Copyright © 2023 Nanjing Solidot Electronic Technology Co., Ltd. 

Table 3-1 Voltage code values 

Range 

Voltage 

0 (default)  1 2 3 

Code value Code value Code value Code value 

-10 -32768  - -27648  - 

-9 -29491  - -24883  - 

-8 -26214  - -22118  - 

-7 -22937  - -19354  - 

-6 -19661  - -16589  - 

-5 -16384  - -13824  - 

-4 -13107  - -11059  - 

-3 -9830  - -8294  - 

-2 -6554  - -5530  - 

-1 -3277  - -2765  - 

0 0  0  0  0  

1 3277  3277  2765  2765  

2 6554  6553  5530  5530  

3 9830  9830  8294  8294  

4 13107  13107  11059  11059  

5 16384  16384  13824  13824  

6 19661  19660  16589  16589  

7 22937  22937  19354  19354  

8 26214  26214  22118  22118  

9 29491  29490  24883  24883  

10 32767  32767  27648  27648  

  D=（65535/20）*U D=（32767/10）*U D=（55296/20）*U D=（27648/10）*U 

  U=（D*20）/65535 U=（D*10）/32767 U=（D*20）/55296 U=（D*10）/27648 

 

3.5.3 Current I/O range selection and code value table 

Analog current I/O range selection and code value range 

Range selection 0 1 2 3 

Range 4~20 mA 0~20 mA 4~20 mA 0~20 mA 

Code value range 0~65535 0~27648 

Current input formula D=65535/16*I-

16384 
D=(65535/20)*I 

D=(27648/16)*I-

6912 
D=(27648/20)*I 

Current output 

formula 

I=(D+16384)*16/6

5535 
I=(D*20)/65535 

I=((D+6912)*16)/276

48 
I=(D*20)/27648 

Code value table See Table 3-2 

Note: D: Code value; I: current 
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Table 3-2 Current code values 

 

Current 

0 (default)  1 2 3 

4-20mA 0-20mA 4-20mA 0-20mA 

Code value Code value Code value Code value 

0 - 0  - 0  

1 - 3277  - 1382  

2 - 6554  - 2765  

3 - 9830  - 4147  

4 0  13107  0  5530  

5 4096  16384  1728  6912  

6 8192  19661  3456  8294  

7 12288  22937  5184  9677  

8 16384  26214  6912  11059  

9 20479  29491  8640  12442  

10 24575  32768  10368  13824  

11 28671  36044  12096  15206  

12 32767  39321  13824  16589  

13 36863  42598  15552  17971  

14 40959  45875  17280  19354  

15 45055  49151  19008  20736  

16 49151  52428  20736  22118  

17 53247  55705  22464  23501  

18 57343  58982  24192  24883  

19 61439  62258  25920  26266  

20 65535  65535  27648  27648  

21 

65535  65535  

29376  29030  

22 31104  30413  

22.81 32511  31538  

22.96 

32767  

 

 

 

31743  

23 31795  

23.52 32511  

23.70 

32767  24 

25 

 

D=65535/16*I-

16384 D=（65535/20）*I 

D= （ 27648/16 ） *I-

6912 D=（27648/20）*I 

Notes: 

In Range 2, when input current＞22.81 mA, the code value displayed is always 32767; when the specified Code 

value＞32511, the output current is always 22.81 mA. 

In Range 3, when input current＞23.52 mA, the code value displayed is always 32767; when the specified code 

value＞32511, the output current is always 23.52 m. 

 

 

Range selection 

 Range 

 



XB6 Series PROFINET Slice I/O User Manual   3 Product Parameters 

12  Copyright © 2023 Nanjing Solidot Electronic Technology Co., Ltd. 

 

 

3.6 Common terminal expansion module parameters 

Common terminal 

Rated voltage 125 VDC/AC 250V 

Rated current 8 A 

Number of common terminals 2 sets 
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4 Panel 

4.1 Coupler panel 

4.1.1 Coupler Structure 

Name and function description of product components 

 

  

Power interface 

Power ID System ID 

Bus interface 
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4.1.2 Indicator function 

Description of IDs and indicators of the power module 

ID Description Color Status Status description 

P 5V indicator Green ON Normal status of working power supply 

Flashing 80% overload. The power supply to real stage load is cut off 

OFF Unpowered or abnormal power supply 

O Overload indicator Red OFF No overload 

ON 90% overload 

Flashing 80% overload. The power supply to real stage load is cut off 

 

Description of IDs and indicators of the coupler module 

Name ID Color Status Status description 

Power indicator P Green 
ON Normal status of power supply 

OFF Unpowered or abnormal power supply 

System indicator L Green 

ON The I/O module is connected, X-bus system is interacted 

Flashing 1Hz 
The I/O module is connected, X-bus system is ready to 

interact  

Flashing 5Hz 
The I/O module is not connected, X-bus system 

configuration abnormal 

OFF The I/O module is not connected or abnormal connection 

Warning indicator B Red 
OFF PROFINET bus parameters are set normally 

Flashing PROFINET bus parameters are not set or abnormal 

Network status 

indicator 
R Green 

ON The system is operating normally 

OFF The system is operating abnormally 

 

Network port status indicator 

ID Color Status Status description 

IN 

Green ON Network connection established 

OFF Absent or abnormal network connection 

Yellow Flashing Connection established with data interaction 

OFF Absent or abnormal network connection 

OUT 

Green ON Network connection established 

OFF Absent or abnormal network connection 

Yellow Flashing Connection established with data interaction 

OFF Absent or abnormal network connection 
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4.2 I/O modules panel 

Name and function description of modules  

 

  

 

I/O module Indicator description 

ID Color Status Status description 

P Green 
ON Normal status of working power supply 

OFF Unpowered or abnormal power supply 

R Green 

ON Normal system operation 

Flashing 1 Hz I/O module connected, X-bus system ready for interaction 

OFF Unpowered, no X-bus data interaction, or abnormal status 

Input channel 

indicator 
Green 

ON  Presence of signal input in module detection channel  

OFF 
Absence of signal input in module channel or abnormal signal 

input 

Output channel 

indication 
Green 

ON Presence of signal output in module channel 

OFF 
Absence of signal output in module channel or abnormal signal 

output 

 

  

Channels of inputs/outputs 

System indicator 

Inputs/outputs indicator 

Channels of inputs/outputs 

Channels of inputs/outputs 
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5 Installation and Disassembly 

5.1 Installation instructions 

Installation and disassembly precautions 

⚫ Ensure that the cabinet is well ventilated. (such as the addition of exhaust fans to cabinets) 

⚫ Do not install this equipment near or above any equipment that may cause overheating. 

⚫ Make sure to install the module vertically and maintain adequate air circulation around it (at least 50 mm 

air circulation space should be provided above and below the module). 

⚫ After the modules are installed, remember to install guide rail fasteners at both ends to fix them. 

⚫ Installation/disassembly operation may only be carried out after the power supply is cut off.  

 

Minimum clearance for module installation (≥50 mm) 
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Make sure the modules are installed vertically 

 

Make sure to install guide rail fasteners 

 

 

5.2 Installation and disassembly steps 

Module installation and disassembly 

Module installation steps 

1. Install the power module on the fixed guide rail first. 

2. Install the coupler and the required I/O modules on the right side of the 

power module. 

3. After installing all required I/O modules, install the end cover to complete 

module assembly. 

4. Install guide rail fasteners at both ends of the power module and end 

cover to fix the module. 

Module disassembly steps 

1. Loosen the rail fasteners at both ends of the module. 

2. Pry loose the module snap fitting with a slotted screwdriver. 

3. Pull out the removed module. 
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5.3 Installation schematic diagrams 

Power module installation  Steps 

 

 

 

 

Align the power module 

guide rail slot vertically 

with the guide rail, as 

shown in the figure① 

 

 

 

           ① 

                    

 

 

Press the power 

module with force until 

a "click" sound is heard. 

The module is now 

installed in place, as 

shown in the figure② 

 

 

② 

 

Coupler module installation  Steps 

 

 

Align the left slot of the 

coupler module with the 

right side of the power 

module, and push it in 

as shown in the figure

③. Press the module 

with force into the guide 

rail until a "click" sound 

is heard. The module is 

now installed in placed. 

③ 
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I/O module installation  Steps 

 

 

 

Install the required IO 

modules one by one 

using the same the 

steps as coupler 

module installation, as 

shown in the figure④⑤ 

 

 

                                ④ 

 

 

 

 

 

 

 

 

 

 

                        

⑤ 

 

End cover installation  Steps 

 

 

Install the end cover on 

the right side of the last 

module, as shown in 

the figure⑥, using the 

same installation 

method as the coupler 

module. 

 

 

  

⑥ 
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Installation of guide rail fasteners  Steps 

  

 

 

Install a guide rail 

fastener next to the left 

side of the coupler, and 

lock it tightly, as shown 

in the figure⑦ 

 

 

 

 

⑦ 

 

Install a guide rail 

fastener on the right 

side of the end cover. In 

this process, first push 

the guide rail fastener 

towards the coupler to 

ensure that the module 

is installed firmly, and 

then lock the fastener 

with a screwdriver, as 

shown in the figure⑧ 

 

 

                                 ⑧ 

 

Disassembly  Steps 

  

 

 

Using a screwdriver, 

loosen the guide rail 

fastener at one end of 

the module, and move it 

to one side to create a 

gap between the 

module and the 

fastener, as shown in 

the figure⑨ 
⑨ 
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Insert the slotted 

screwdriver into the 

snap fitting of the 

module to be removed, 

and exert force along 

lateral direction of the 

module (until a click 

sound is heard), as 

shown in the figure⑩⑪ 

Note: Each module 

has two snap fittings, 

one on the top and 

the other at the 

bottom. Both should 

be operated in this 

way 

 

 

                                     

⑪ 

 

 

 

 

 

 

Remove the module in 

the reverse order of 

installation, as shown in 

the figure⑫。 

 

 

                           

 

⑫ 

  

⑩ 
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5.4 Dimension 

Power module dimensions (Unit: mm) 

 

 

 

Coupler module dimensions (Unit: mm) 
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Extension power module dimensions (Unit: mm) 

 

 

I/O module dimensions (Unit: mm) 
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End cover module dimensions (Unit: mm) 

 

Note: All installed with DIN 35 mm standard guide rail, specification 35*7.5*1.0 (unit mm) 
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6 Wiring 

6.1 Wiring terminal 

Wiring terminal 

Signal wire terminal 

Number of poles 16 P 

Number of poles 20 P 

Wire gauge 22~17 AWG  0.3~1.0 mm² 

Power terminal 
Number of poles 3P 

Wire gauge 22~16 AWG  0.3~1.5 mm² 

Bus interface 2*RJ45 Category 5 or better UTP or STP (STP preferred) 

 

6.2 Wiring instructions and requirements 

Power wiring precautions 

⚫ The power supply on the module system side and that on the field side should be wired separately. Mixing 

should be avoided. 

⚫ PE should be grounded reliably. 

  



XB6 Series PROFINET Slice I/O User Manual   6 Wiring 

26  Copyright © 2023 Nanjing Solidot Electronic Technology Co., Ltd. 

Wiring tool required 

 

As the terminals are based on a screw-free design, cable installation and 

removal can be realized with a slotted screwdriver (size: ≤ 3 mm). 

 

Stripping length required 

 

Recommended stripping length: 10 mm 

Wiring method 

For a single-strand hard wire, after stripping a required length, press the 

button while inserting the single-strand wire 

 

For a multi-strand flexible wire, after stripping a required length, directly 

connect it or use a compatible cold-pressed terminal (tubular insulated 

terminal, as shown in the table below). Press the button whiling 

inserting the wire. 

   

 

Terminal specifications are shown in the following table:  

Specification of tubular insulated terminal 

Specification Model Cable section area (mm²) 

 

 

 

 

 

Length of tubular insulated terminal L ≥10 mm 

E0310 0.3 

E0510 0.5 

E7510 0.75 

E1010 1.0 

E1510 1.5 
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Power supply wiring: 3P terminal of power module 

Connect the DC24V power module using the given wiring method based on the circuit shown in the figure below, 

and meanwhile ground the PE reliably (twisted pair cable is recommended for power supply) 

⚫ Figure 6-1: Wiring diagram of coupler, IO modules, and power module in sequence 

  

Figure 6-1 

 

 

⚫ Figure 6-2: Wiring diagram of coupler, IO modules, power module, IO modules, and power module in 

sequence 

 

Figure 6-1 
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Load power supply wiring: 20P terminal on the field side 

Press the signal cable into the wiring terminal by referring to the I/O module wiring diagram and wiring method. 

24 VDC power supply is used for loads. Using the given wiring method, connect the power supply according to 

the circuit shown in the left figure. Refer to 6.4 I/O module wiring diagram for details. 

 

Signal terminal wiring: 16P\20P terminal 

Press the signal cable into the wiring terminal by referring to the I/O module wiring diagram and wiring method. 

 

Bus wiring: Industrial Ethernet bus communication interface 

The standard RJ45 network interface with a standard crystal connector is used, and the pin assignment is shown in 

the figure below. 

8

1

1

8

 

 

 Precautions 项 

⚫ Category 5 or higher-level double-shielded (braided wire + aluminum foil) STP cable is recommended as 

communication cable 

⚫ The cable between any two devices should not exceed 100 m 

 

 

Pin Signal 

1 TD+ 

2 TD- 

3 RD+ 

4 一 

5 一 

6 RD- 

7 一 

8 一 
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6.3 XB6-PN0002 communication interface wiring 

Some of the XB6-PN0002 coupler network ports silk-screened ID are and identified as IN/OUT, as shown in 

the figure below. 

When wiring, you need to connect the network topology according to the corresponding scenario example, 

otherwise communication failure may occur. 

 

6.3.1 Scenario 1: Only one XB6-PN0002 module in the network 

When there is only one group of XB6-PN0002 modules in the network： 

⚫ "IN" port is connected to any network port of the previous node device; 

⚫ "OUT" port is connected to any network port of the latter node device, as shown in the figure below. 

When connecting to devices of other manufacturers, the network topology specification of the corresponding 

manufacturer should be followed. 

 



XB6 Series PROFINET Slice I/O User Manual   6 Wiring 

30  Copyright © 2023 Nanjing Solidot Electronic Technology Co., Ltd. 

6.3.2 Scenario 2: Multiple XB6-PN0002 modules in the network 

When there are multiple XB6-PN0002 modules in the network: 

⚫ The first module’s "IN" port is connected to any network port of the previous node device; 

⚫ The last module’s "OUT" port is connected to any network port of the latter node device; 

⚫ The connection between modules must follow the principle of "IN" to "OUT", as shown in the figure 

below. 

When connecting to devices of other manufacturers, the network topology specification of the corresponding 

manufacturer should be followed. 

 

 

 

6.3.3 Scenario 3: Using a switch in a network 

When a switch is used in the network: 

⚫ The "IN" port of the module is connected to any network port of the switch; 

⚫ The connection between the modules must follow the "IN" to "OUT" principle, as shown in the figure 

below. 

When connecting to devices of other manufacturers, the network topology specification of the 

corresponding manufacturer should be followed 
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6.4 I/O module wiring diagrams 

XB6-3200N, XB6-0032AN, XB6-0032BN Wiring diagrams refer to the “XB6 Series_MIL Connector Type IO User 

Manual”. 

6.4.1  XB6-3200A 

XB6-3200A  Module Panel 

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DIa

DIb

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F
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6.4.2  XB6-3200B 

XB6-3200B  Module Panel 

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DIa

DIb

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

 

6.4.3  XB6-1616A 

XB6-1616A  Module Panel 

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DI

DO

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F
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6.4.4  XB6-1616B 

XB6-1616B  Module Panel 

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DI

DO

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

 

6.4.5  XB6-1600A 

XB6-1600A  Module Panel 

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DI
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6.4.6  XB6-1600B 

XB6-1600B  Module Panel 

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DI

  

6.4.7  XB6-0800A 

XB6-0800A  Module Panel 

DI

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V
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6.4.8  XB6-0800B 

XB6-0800B  Module Panel 

DI

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

  

6.4.9  XB6-0032A 

XB6-0032A  Module Panel 

DOa

DOb

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F
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6.4.10  XB6-0032B 

XB6-0032B  Module Panel 

DOa

DOb

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

  

6.4.11  XB6-0016A 

XB6-0016A  Module Panel 

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

DO
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6.4.12  XB6-0016B 

XB6-0016B  Module Panel 

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

DO

  

 

6.4.13  XB6-0008A 

XB6-0008A  Module Panel 

DO

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V
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6.4.14  XB6-0008B 

XB6-0008B  Module Panel 

DO

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

  

6.4.15  XB6-0012J 

XB6-0012J  Module Panel 

Power +24V

Power 0 V

Output 0

DOa

Output 1

Output 2

Output 3

Output 4

Output 5 COM

COM

COM

COM

COM

COM

Output 6

Output 7

Output 8

Output 9

Output A

Output B COM

COM

COM

COM

COM

COM

Power +24V

Power 0 V

DOb
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6.4.16  XB6-A80V/XB6-A80I 

XB6-A80V/XB6-A80I  Module Panel 

COM

AI
Input 

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

COM

COM

COM

COM

COM

COM

COM

两线制传感器

+24V

0V
三线制传感器

四线制传感器

+24V

0V

+24V

0V

信号线缆：建议采用屏蔽双绞线*
  

 

6.4.17  XB6-A40V/XB6-A40I 

XB6-A40V/XB6-A40I  Module Panel 

 

COM

AI
Input 

Input 1

Input 2

Input 3

COM

COM

COM

COM

COM

COM

COM

两线制传感器

+24V

0V
三线制传感器

+24V

0V

信号线缆：建议采用屏蔽双绞线*

四线制传感器

+24V

0V

 

 

Note:  

The screen printing of module 

XB6-A80I is XB6-A80I. 

 

Note:  

The screen printing of module 

XB6-A40I is XB6-A40I. 

 

*Signal cable: shielded twisted pair cable is recommended 

*Signal cable: shielded twisted pair cable is recommended 
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6.4.18  XB6-A08V/XB6-A08I 

XB6-A08V/XB6-A08I  Module Panel 

Power +24 V

Power 0 V

Power +24 V

Power 0 V

COMOutput 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

COM

COM

COM

COM

COM

COM

COM

信号线缆：建议采用屏蔽双绞线*
  

 

6.4.19  XB6-A04V/XB6-A04I 

XB6-A04V/XB6-A04I  Module Panel 

Power +24 V

Power 0 V

Power +24 V

Power 0 V

COM

AO
Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

COM

COM

COM

COM

COM

COM

COM

信号线缆：建议采用屏蔽双绞线*
 

Note:  

The screen printing of module 

XB6-A08I is XB6-A08I. 

 

Note:  

The screen printing of module 

XB6-A04I is XB6-A04I. 

 

*Signal cable: shielded twisted pair cable is recommended 

*Signal cable: shielded twisted pair cable is recommended 
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6.4.20  XB6-A80TM 

XB6-A80TM  Module Panel 

Input 0+

com

S

Input 0-

Input 1+

com

S

Input 1-

Input 2+

com

S

Input 2-

Input 3+

com

S

Input 3-

Input 4+

com

S

Input 4-

Input 5+

com

S

Input 5-

Input 6+

com

S

Input 6-

Input 7+

com

S

Input 7-

2 线制温度传感器

3 线制温度传感器

2 线制温度传感器

3 线制温度传感器

S S

S S

 

  

2-wire temperature sensor 

3-wire temperature sensor 

2-wire temperature sensor 

3-wire temperature sensor 
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6.4.21  XB6-A40TM 

XB6-A40TM  Module Panel 

Input 0+

com

S

Input 0-

Input 1+

com

S

Input 1-

Input 2+

com

S

Input 2-

Input 3+

com

S

Input 3-

S S

S S

 

  

2-wire temperature sensor 

3-wire temperature sensor 
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6.5 Common terminal expansion module wiring diagrams 

The wiring method of two-wire and three-wire sensors is described in this section, taking the two modules of 

XX6-1616A/B as examples. 

Wiring method of two-wire sensor (NPN type) 

 

Wiring method of two-wire sensor (PNP type) 
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Wiring method of three-wire sensor (NPN type) 

 

Wiring method of three-wire sensor (PNP type) 
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7 Operation 

7.1 Module application 

Two combinations are available for the product as shown below, each containing a coupler, I/O modules and an 

end cover. 

First product combination (coupler, I/O modules, end cover) 

  Coupler             I/O modules   End cover 
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Coupler            I/O modules   extension power module   I/O modules   end cover 

 

Please refer to the following principles for the number of I/O modules to be configured: 

1. The number of IO modules that can be supported by a coupler is not higher than 32. 

2. The number of analog modules should not exceed 12, and the number of 8-channel analog inputs 

should not exceed 8. 

 

7.2 Module parameters configuration function 

7.2.1 Digital input filtering 

Digital input filtering can prevent unexpected rapid changes in program response input signals. Such changes 

may result from jumping of switch contact or electrical noise. The default value of digital input filtering is currently 

fixed at 3ms and all clutters within 3ms can be filtered out. Separate channel configuration is not allowed. 

The 3ms input filtering time means that a single signal changing from 0 to 1 or from 1 to 0 can only be 

detected after 3ms has lapsed following such change, while a single high pulse or low pulse shorter than 3ms 

will not be detected 

Configuration method 

See 7.3 Bus module configuration description 

* After the modification, it is recommended to repower the module 

 

7.2.2 Analog filtering configuration function 

⚫ Analog input filtering function 

The analog input filtering function can average the data internally after A/D conversion to reduce the 

fluctuation effect on input signals due to noise. 

Analog inputs are subject to moving average processing based on the specified A/D conversion times. 

⚫ Filtering function configuration 

Each channel can be configured separately. Configuration range: 1~200, default: 10. 

Sampling rate of 8-channel module: 1.25 KHZ/8 channels (800 us/8 channels) 

Sampling rate of 4-channel module: 2.5 KHZ/4 channels (400 us/4 channels) 

Second product combination (coupler, I/O modules, extension power module, I/O modules, end cover) 
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Configuration method 

See 7.3 Bus module configuration description 

* After the modification, it is recommended to repower the module 

 

7.2.3 Digital output clearing and holding function 

Output holding: When the communication is disconnected, the module output channel will maintain its output 

Output clearing: When the communication is disconnected, the module output channel will clear its output 

Configuration method 

See 7.3 Bus module configuration description 

* After the modification, it is recommended to repower the module 

 

7.2.4 Analog range selection 

The analog range setting function is used to set the analog range (see 3.5 Analog Parameters for details). 

Configuration method 

See 7.3 Bus module configuration description 

* After the modification, it is recommended to repower the module 

 

 

7.3 Bus module configuration description 

7.3.1 Application in TIA Portal V14 software environment 

1. Preparations 

Hardware environment 

A computer installed with TIA Portal V14 software 

A Siemens PLC 

Dedicated PROFINET shielded cables 

A switching power supply 

Module installation guide rail and fasteners 

Module model:  

Type Model Number 

PLC S7-1200 1 

Coupler XB6-PN2002ST 1 

I/O Modules 

XB6-3200B 1 

XB6-3200A 1 

XB6-1616B 1 

XB6-A80V 1 

End cover XB6-CVR00 1 

Device configuration files   

Website of configuration files：https://www.solidotech.com/documents/configfile 

Hardware configuration and wiring 

Please operate according to “5 Installation and Disassembly” and “6 Wiring”. 

https://www.solidotech.com/documents/configfile
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2. Project Creation 

1. Open the TIA Portal V14 software. 

2. Click "Create New Project" 

 

Project name: Customize, can keep the default. 

Path: The project keeps the path, which can be kept as default. 

Version: Keep the default. 

Author: You can keep the default. 

Comment: Custom, can be left blank.  
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3. Adding a PLC 

1. Click "Configure a device" 

 

 

2. click "Add new device", select the PLC model you are currently using, and click "Add", as shown in 

the below figure 

 

Check to see that the PLC has been added to the device navigation tree. 

 

4. Scan devices 

1. Click "Online Access” -> “Update accessible devices" in the left navigation tree, as shown in the 

figure below. 
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After the update, the connected slave devices are displayed, such as the below figure. 

 

The IP address of the computer must be in the same network segment as the PLC, if not, change the 

IP address of the computer and repeat the above steps. 

 

5. Add a GSD configuration file 

1. In the menu bar, click "Options > Manage general station description files (GSD)”. 

2. Click "Source path" to select the file. 

Check whether the status of the GSD file to be added is "Not yet installed", if it is installed, click 

“Cancel” to skip the installation step.  

 

6. Add a slave device and modify the device name and IP address 

1. Double-click "Devices and networks" on the left navigation bar. 

2. Click the "Hardware Directory" vertical button on the right side to display the following directory.  

 

3. Select "Other Field Devices > PROFINET IO > I/O > Sdot > X-Bus > XB6-PN0002".  

4. Drag or double-click "XB6-PN0002" to the "Network View", as shown in the below figure. 
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5. Click "Unassigned (blue font)" on the slave device and select "PLC_1.PROFINET interface_1", as 

shown in the figure below 

 

After the connection is completed, as shown in the figure below. 

 

6. Click on the device name and rename the device, as shown in the figure below.  

 

7. Open "Device View" and change the IP address in "Properties", as shown in the following figure. 

 

8. Add I/O modules according to the actual topology in the "Modules" directory on the right (the 

order must be consistent with the actual topology, otherwise the communication will not be 

successful), as shown in the figure below. 
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Up to 32 modules can be added, I/O address is assigned by the system, or you can change it by 

yourself 

9. Switch to "Network View", right-click on the connection line between PLC and PNIO, and select 

"Assign Device Name". 

 

10. The "Assign PROFINET Device Name" window pops up, as shown in the following figure. 

 

Check whether the MAC address on the coupler silkscreen is the same as the MAC address of the 

assigned device name. 

PROFINET device name: The name set in "Assign IP address and device name to slave". 

Type of PG/PC interface: PN/IE. 

PG/PC interface: The actual network adapter used. 11. 

 

11. Select the slave device in turn, click Update List, and then click Assign Name. 

Check whether the status of the node in "Accessible Nodes in Network" is "OK", for example, as 

shown in the figure below. 
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Click Close to close the page. 

 

7. Download the configuration structure 

1. In the "Network View", select PLC 

2. Click the  button in the menu bar to download the current configuration to the PLC.  

3. In the pop-up "Extended Download to Device" screen, configure as shown below. 

 

4. Click the "Start Search" button. 

5. Click "Download". 

6. Select "Continue without synchronization". 

 

7. Select "Stop All". 
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8. Click "Load".  

9. Click "Finish".  

10. Power the device back on.  

 

8. Communication Connection 

1. Click button.  

2. Click the "Go to Online" button to connect successfully, as shown in the figure below. 

 

 

9. Check the device indicator 

XB6-P2000H: P light is always on in green. 

XB6-PN0002: P light is always on, L light is always on, B light is not on, R light is always on. 

I/O module: P light is always on, R light is always on.。 

 

10. I/O Verification 

1. Expand the project navigation on the left side and select "Monitor & Force Table", as shown in the 

figure below. 
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2. Double click "Add New Monitoring Table" to add a new monitoring table to the system, for 

example, as shown in the figure below. 

 

 

3. Click button. 

Open "Device Overview" to view the channel Q address (the channel address of the output 

signal) or I address (the channel address of the input signal). For example, the "Q Address" of the 

XB6-1616B module is 2 to 3, as shown in the figure below.  

 

 

4. Enter "QB3" in the address cell of the monitoring table, as shown in the figure below.  

 

 

5. Press "Enter" and the system will display as follows. 

 

 

6. Enter the value in the Modify Value cell and click Write to view the channel indicator. 8. 

7. Enter IB+"I address" in the address bar to monitor the input module. 
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11. Parameter Setting 

Setting the input filter 

1. Open the Device View.  

2. Select the input module and click "Module Parameters" to set the filtering, as shown in the figure 

below. 

 

After the configuration is finished, you need to re-power the module. 

 

Set the output clear hold 

1. Open Device View.  

2. Select the output module, click "Module Parameters", and set the clear hold, as shown in the 

following figure. 

 

Hold: Hold the output, the module output channel will keep output when the network 

communication is disconnected. 

Clear: Clear the output, when the network communication is disconnected, the module output 

channel clears the output. 

After the configuration is finished, it needs to be re-powered. 

 

Set the analog range 

1. Open the “Device View”.  

2. Select the analog module and click "Module Parameters" to set the analog range, for example, 

the following figure. 

 

The default range “-10~10V -32768~32767”。 

After the configuration is finished, it needs to be re-powered. 
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7.3.2 Application in STEP 7-MicroWIN SMART software environment 

1. Preparations 

Hardware environment 

A computer installed with STEP 7-MicroWIN SMART software 

A Siemens PLC 

Dedicated PROFINET shielded cables 

A switching power supply 

Module installation guide rail and fasteners 

Module model:： 

Type Model Number 

PLC S7-200 SMART 1 

Coupler XB6-PN2002ST 1 

I/O Modules 

XB6-3200A 1 

XB6-0032A 4 

XB6-0032B 1 

XB6-A40V 1 

End cover XB6-CVR00 1 

Device configuration files   

Website of configuration files：https://www.solidotech.com/documents/configfile 

Hardware configuration and wiring 

Please operate according to “5 Installation and Disassembly” and “6 Wiring”. 

 

 

2. Add a CPU 

1. Open the STEP 7-MicroWIN SMART software. 

2. Double click the left navigation tree button to bring up the "System Block" window 

3. Select the CPU model, as shown in the figure below. 

 

4. Double-click the Navigation Tree button  to bring up the "Communication" screen.  

5. Click  button. 

https://www.solidotech.com/documents/configfile


XB6 Series PROFINET Slice I/O User Manual   7 Operation 

59  Copyright © 2023 Nanjing Solidot Electronic Technology Co., Ltd. 

6. Click the "Settings" button to modify the IP address. 

 

 

3. Manage GSD files 

Add GSD files 

1. Click "File -> GSDML Management".  

2. Click the "Browse" button. 

3. Select the GSDML file you want to import. 

Delete a GSD file 

1. Click "File -> GSDML Management". 

2. Select the GSDML files to be deleted in the check box. 

3. Click "Delete". 

 

4. Device Naming 

1. Select "Tools -> Find PROFINET Devices". 

2. Click "Find Device". 

3. Click Edit to change the device name. 

 

5. Configuring PROFINET Networks 1. 

1. Click Tools -> PROFINET to open the PROFINET Configuration Guide. 

2. Select the PLC role as "PROFINET Controller". 

 

3. Click on "Next". 
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4. Configure the controller parameters as shown in the figure below. 

 

The device name should be the same as the module name, and the IP address should be set 

in the same network segment as the PLC. 

 

5. Click Next to add I/O modules, for example, as shown in the following figure. 

 

6. Click "Next" and click "Generate" button.  

 

6. Download the program 

1. Click the "Download" button, the following dialog box will pop up. 

 

2. Click "Download". 
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After the download is completed, re-power the module to process. 

 

7. Test Data 

1. Click the "RUN" button to put the CPU in RUN mode. 

 

2. Click "OK". 

3. Double click "Status Icon -> Chart 1" in the navigation tree, the system displays the status icon. 

4. Enter the corresponding channel address and data format, where you can force and input 

monitoring for I/O modules, as shown in the figure below. 
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8 FAQ 

8.1 When updating accessible devices, the device is not found 

1. Make sure that the botu software is installed correctly. 

2. Make sure there is no other software occupying the network adapter used by the Botu software. 

3. Make sure the network cable, network card and network port can work properly. 

4. IP address or MAC address conflict.。 

 

8.2 Load button is gray when downloading configurations 

1. Confirm that there is no forced value in the PLC. 

2. Verify that the PLC is in stop state. 

 


